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Pre-Load To-Do List
In order to use PowerLoader there are some preparatory steps you need to take. The following list contains
items you should have in place on your computer before using PowerLoader:
1. 1010data account with API access
We'll assume that if you're reading this guide you're already a 1010data client (which automatically
makes you awesome!). However, to use many of our supplemental products, such as TenDo, the
ODBC driver, and yes, PowerLoader, you also need API access. If you're not sure if you have API
access or not, contact your 1010data sales representative.
2. PowerLoader FTP account
Once you have API access as part of your 1010data account, you automatically have access to
PowerLoader. Your PowerLoader account is the same Username and Password as your normal
1010data account. However, if you intend to use PowerLoader you should contact 1010data to setup
an FTP account. This account will provide you with the access needed to upload your raw data via FTP
before you load it into 1010data with PowerLoader.
3. The data you intend to load in a compatible file format
In order to load your data via PowerLoader, you will need to output your data from your current system
into a file format that can be read by PowerLoader. The compatible file types are as follows:
.txt - a standard text file
.csv - a comma-separated values file
.zip, .7z, .rar, .tar.gz - a compressed file in one of these formats containing either of the
above file formats
4. An FTP Client
•
•
•

If you're not familiar with FTP, don't let it scare you. FTP simply stands for: File Transfer Protocol, and
it's a very common way to transfer files between computer systems. There are many, many free FTP
clients for almost every kind of operating system and environment you can imagine. However, most
of our PowerLoader users simply use a free client called FileZilla. It is an open source, free software
product that you can download here: www.filezilla-project.org. We will look at how to use the FTP client
a little later in this guide. But for now, make sure you have one installed on your system.
Now that you have all the items above checked off the list, we can upload your data to 1010data with
PowerLoader. In the next section, we'll take a look at each step in detail, as well as all the fields and
options available during the upload process.
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Login to PowerLoader
To login to PowerLoader, simply follow this link: www2.1010data.com/powerloader2. You should arrive at
the following screen:

To login, enter your 1010data Username and Password. Then, click the Login button. After your
credentials have been verified you'll end up at the following screen:

The screenshot above shows 1010data's generic folders in a test environment. You should see your own
folders instead.
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Upload Data Files to PowerLoader
There are two ways you can upload your data into 1010data PowerLoader. This section will cover both
methods.
In order to upload your data for use with PowerLoader, you will require a 1010data FTP account. If you're
not sure whether you have an account, contact 1010data.
Before you can upload a file, you need to make sure it is in the correct format. PowerLoader accepts files
in the following formats:
•
•

Text file: A file with a ".txt" extension that contains only text data.
Comma Separated Values file: A file whose values are separated (or delineated) by a comma
character (',').

Most applications can out put their data in either of these files types, including MS Excel.
Note: To export your Excel spreadsheet choose one of the following options: File > Save as... >
Format > Comma Separated Values (.csv) or File > Save as... > Tab Delimited Text (.txt).
If you save your data in a Text file format, it will look something like this when you open it in a text editor:

If you save your data in the Comma Separated Values file format it will look like this when you open it in a
text editor:
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Notice in the second file example there are no spaces or blank lines. Instead, the values for each record
(i.e., row) are separated by the comma character (','). Hense the name of this file format.
As you can see, neither of these formats is very practical for human consumption. However, these options
are the fastest options for a computer to read data and store it remotely.
Once you have your data in one of these formats you are ready to upload it to PowerLoader with either of
the following two options.

Upload a File using an FTP Client
While you do have access to a lightweight, web-based FTP tool within PowerLoader, 1010data strongly
recommends using a third-party FTP client to upload your files. You can use any FTP client you can find.
Almost all are free to download and use. Below is a list of common FTP clients and sites where they can
be downloaded:
Note: 1010data does not recommend or support any specific FTP software. The table below
consists only of examples for your convenience.
Table 1: Common FTP Clients
FTP Client Name
FileZilla
SmartFTP
CuteFTP

Download Location
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FTP Client Name

Download Location

CoreFTP
Regardless of the FTP client you chose, the basic anatomy is the same. The screenshots below are taken
from the FileZilla FTP client, but all FTP clients require and display the same basic information. First, you'll
need to enter the correct connection information, as follows:

In order to connect to the 1010data FTP server you need to enter all four pieces of this information. The
table belows gives more detail about each:
Table 2: FTP Connection Options
FTP Connection information

Description

Value

Host

The URL of 1010data's FTP
server.

ftp2.1010data.com

Note: Some 1010data
clients may use a different
FTP server. Contact your
1010data representative if
the default server doesn't
allow you to connect.
Username

Your 1010data FTP account
username. This is a separate
account from your normal
1010data login information.

Your 1010data FTP account
username

Password

Your 1010data FTP account
password. This is a separate
account from your normal
1010data login information.

Your 1010data FTP account
password

Port

The TCP/IP port your computer
uses to communicate with the
1010data FTP server.

22

Note: 1010data uses the
secure FTP protocol.
Note: Corporate firewalls and proxy servers sometimes block FTP transactions. If you are having
trouble using FTP for PowerLoader, contact your IT department.
After you successfully authenticate with the 1010data FTP server you should be able to navigate to the
local file on your computer you want to upload and send it to the FTP server. Again, all FTP clients will look
something similar to the following:
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In the screenshot above, the left side contains the local folders and files on your computer. The right side
contains the remote folders and files; in other words the folders and files on the FTP server. Simply click
and drag the file(s) you want to upload from the pane on the left side of the window to the empty pane on
the right side. Your file will automatically be transferred to the 1010data FTP server.

The 1010data FTP web interface
If you don't feel comfortable downloading and installing a third-party FTP client, or if you don't have
permission to install third-party applications on your office computer, you can use the 1010data web-based
FTP client.
Note: The 1010data web-based FTP client does not work on Macintosh computers. If you have a
Mac, please download a third-party FTP client and follow the directions in the previous section.
To upload your data with the web-based FTP utility provided by 1010data, login to Power Loader using
your 1010data account. Once logged into PowerLoader, click the Load Table link at the top-right corner of
your screen, circled in red below:

Once you've clicked the Load Table link you'll be at the main PowerLoader screen. The top of this screen
is shown below:
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To upload a new table, click the Upload link (circled in red above). Upon clicking the link a pop-up window
will appear. In the screenshot below, the Select a file to add to Queue drop-down menu is used to browse
to the file you want to upload.

Once you find the file on your computer, click the Upload File button, indicated by the red arrow in the
following screenshot:
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Your file should now appear in the Upload Queue section of the screen in the File Name column as
indicated by the green arrow in the screenshot above. When the progress bar finishes, your file will be
available in PowerLoader.
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PowerLoader File Configuration
This section describes how to use PowerLoader to load data into the 1010data environment once you've
uploaded it to your FTP account. If you've successfully done this, you're ready to load it into 1010data.
Once you've sent your file to 1010data via FTP, login to PowerLoader if you haven't already. You will
arrive at a screen which shows the folders you currently have access to in the 1010data system. Select
the location in 1010data where you want to save the new table you're creating by loading the new file. If
you're loading sales data and you have a sales folder, it's likely the sales folder is what you want to select.
I'm using sample files that we here at 1010data created for training purposes, so I'm going to select my
Training Examples folder. Once you've highlighted your desired location, click the load table link shown
in the screenshot below:

You should now be on the Load Table screen of PowerLoader. This is where we tell PowerLoader how we
want it to be formatted in 1010data. The first section of this screen is to choose the file you want to load
(and you hopefully have uploaded via FTP) and several other pieces of information about the data in this
file. This screenshot shows the Input File section:
Note: Once you've selected all the options for your file in PowerLoader you can save the settings
so they can be used again. This is a great feature if you regularly use PowerLoader to load files
with the same data format (such as weekly sales data). We'll cover this more in a bit, but for now,
we just thought you'd like to know.

At the top of the Load Table screen there are several menu items as follows:
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Table 3: Load Table Menu
Menu Option

Description

Open

Open a previously saved PowerLoader
configuration

Save

Save your current PowerLoader configuration

AutoFill

Tells PowerLoader to make its best guess as to the
correct settings for your file

Browse

Select another location to load your file

To get started, make sure your file is selected in the file list (just above the type drop-down). Now,
before you do anything else, click the AutoFill link (circled in green above). The AutoFill feature tells
PowerLoader to look at the data in your file and make the best guess it can as to the columns and records
the file contains. While you may need to make some adjustments afterward, AutoFill can save you a lot of
work. The next screenshot shows the Load Table screen before clicking AutoFill.
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The next screenshot shows what happens after clicking AutoFill:
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The screenshot, while long, is actually truncated. But, you can see that PowerLoader went through the
data file and identified every column in it and filled in some basic information about each of them. Now you
don't have to manually added a new Column Information section for each column in your data file. Now
that we've had a little help, let's go back to the top and look at each setting for each section.
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Table Information
The following table provides descriptions for each option in the Table Information section of the
PowerLoader utility. Required fields are titled in red.

Table 4: Table Information fields
Field

Description

Name

The name of your table. This is the unique name
of the table used for identification in the 1010data
system.

Title

The title of your table. This is for your own
recognition of the table and doesn't necessarily
have to be unique.

Short Description

A brief description of the data contained in your
table

Long Description

A detailed explanation of the data contained in your
table

Link Header

Denotes columns that were not originally part of
your table but have made part of the table as the
result of linking another table.

Time Series

See next section

User

Shows which user(s) have permission to view the
table. You can specify additional users you want to
have access to the table in this field.

The Time Series Option
One of the features that makes 1010data such a powerful analytics platform is its ability to efficiently
perform operations on data over time. The 1010data XML Macros Language has several dozen functions
designed specifically for time series analysis operations. We don't have enough space for a full explanation
of Time Series analysis in this document, but if you want to learn more you can find lots of useful
information in the 1010data General Help documentation.
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If you've used Time Series functions or Group functions in 1010data in the past, you might be aware of the
fact that these functions only operate on specific chunks of the data in a table. These chunks are called
segments. Without getting into too much detail we can say that the data is broken into segments because
it is more efficient to perform operations on smaller segments of data than it is to do so on a large chunk.
The only drawback to this model is that sometimes when a value appears at the end of one segment there
may not be enough room left in the segment for all the records with that value to be contained within it. The
Time Series option in PowerLoader allows you to make sure everything stays grouped, or, segmented
correctly. If you set this option to YES a new box will appear in all the Column Information sections of
PowerLoader, as follows:

The Time Series Break Order text box accepts whole number values starting with 1. If we placed a 1 in
the box above, 1010data would know to break the table up in such a way that all entries with the same
transaction number should be located in the same segment. That way any Time Series or Group functions
that you perform which include that transaction number are able to operate on all instances of it. If you
need to make sure a combination of values is properly grouped together, simply order the numbers you
place in the Time Series Break Order box sequentially. If you place a 1 in the AccountID column and a
2 in the Store column and a 3 in the Date column, then 1010data will break the data up into groups and
make sure that all records with a unique combination of AccountID and Store are in the same group.
Putting a 3 in the Date column tells the system to sort the table byDate. In fact, the system will always
initially sort the base table being loaded by the column with the highest value in the Time Series Break
Order box. So, if in our previous example we did not include a 3 in the Date column, then the system
would make sure the data is grouped in such a way that all unique AccountID values are in the same
segment. Then, it would sort the table by the Store column, not the Date.
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Column Information
For every column in your table you will need to provide PowerLoader with information required by the
1010data system. If your data file was formatted and deliniated properly, the AutoFill feature should
identify the number of columns in your table, create a section for you to provide the necessary information
and populate the fields it can. However, it can't write descriptions for you. The following table provides
descriptions of all fields and options in the Column Information sections of PowerLoader.

Table 5: Column Information fields
Field

Description

Name

This is the unique name of your column. The
Column Name provides a unique identifier for each
column of a table in the 1010data interface. The
Column Name must be all lower-case letters with
no spaces.

Header

The header of a column is the name you designate
for the top of each column of your table in the
1010data interface. Unlike the Column Name, your
header can contain capital letters and spaces.

Column Help

Explains the values and their meaning in a given
column. Visible when you click on the '?' character
in a column or go to column info.

Expression

Macro language expression for computed columns.
Also helps control formatting for date and time data.
Note: Expressions are built from a subset
of the 1010data Macros Language. All
functions from the Macro Language are
available for use in expressions except for
g_ (group), r_ (row) and ts_ (time-series)
functions.

Fixed Column (Pink)

When you choose the Y option in this drop-down
menu, the column will remain in its current position
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Field

Description
when you scroll horizontally through the table
columns in the 1010data GUI.

Hide column

Creates the column in 1010data, but hides it. The
column will be available in the Rearrange columns
dialog in 1010data. Hidden columns are also
available for use in expressions.

Destroy column

Does not load at all. The column will be unavailable
in 1010data base table after it is created. This
setting is often used to eliminate column headers
from the data file so that are not listed in the first
row of the 1010data table that is created.

Type

This is the data type of the values in a particular
column. 1010data columns support many data
types. See the next section of this document for
short descriptions of each data type supported.

Format Type

See the "Type" section below

Display Width

Specifies the number of characters or decimal
places in the value of the column.

You may have noticed that above each Column Information dialog there are several small icons that look
like this:

The following table contains a description of the function of each of these buttons:
Table 6: Column Information buttons
Button

Function
Add a new column to the table. All the values in the
new column will be blank.
Clone a column so that an exact copy, with all
associated values, is created.
Move this column up in the order. This will move the
column to the left in the final table
Move this column down in the order. This will move
the column to the right in the final table
Delete this column

The Type, Format Type and Force Case Options
In the Column Information sections of PowerLoader you have the ability to select a Type for the data in a
column. This option tells 1010data what kind of data is contained in the column. For instance, if the column
contains only whole numbers, the Type is Integer. If the column holds dollar values or any other kind
of number with decimal places, the Type is Float. Once a Type is selected, you then have the option to
select a Format Type. This option tells the system how the data should look on the screen. For example,
you can select Number (w/ commas) or Number (w/o commas). Neither of these changes the kind of
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data in the column. Either way the data in the column is still a number. Instead, this option determines the
appearance of the numbers when displayed on the screen. Below is an outline of the major Type options:
Note: When building 1010data expressions, the type of data in the column is used to determine
the type of data passed to the expression. However, the resulting column type is controlled by the
expression itself.
Table 7: Format and Type options
Type

Description

Text

Signals that the column contains text, as opposed
to numbers.
Note: Notice that when this option is
active, the Format Type drop-down
changes to the Force Case drop-down.
This allows you to convert all the text data
in the column to all upper or lower case
letters.

Integer

Any whole number. 1, 53 and 1,234,597 are all
examples of integers.

Float

Any number with place values to the right of a
decimal point. 1.1, 23.845 and 0.37383636833930
are all examples of floating point numbers.

Expression

Allows you to derive the value of a column with a
1010data Macro Language expression.

In addition to the types mentioned above, there are also numerous options for date and time data. These
data formats apply 1010data date formatting measures to the date data found in the source file. Dates in
an input file can be formatted with dashes ('-'), forward-slashes ('/') and spaces (' '). Data loaded with just
date information are created as integers in 1010data, with time-handling formats applied as specified in the
Type drop-down menu. Data with date and time data are created as floats in 1010data, with the applicable
time-handling formats applied as specified in the Type drop-down menu.
Once you've completed all necessary fields it's time to send your data to the 1010data system. You
may have noticed a small box with a header that says Load at the top following you up and down the
PowerLoader screen. When you have entered all the table and column information necessary to load
your file, click the Submit button on the Load box to complete your data-load onto 1010data. The Submit
button is circled in red below:

Once you gain some comfort and familiarity with PowerLoader it will become a valueable tool in your
1010data toolbox. Afterall, it's what you do with your data once it's on our system that really matters.
PowerLoader will get you to that point faster and more efficiently.

